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Huntron Workstation Oscilloscope  Software Tutorial  

Huntron Work station software  

It is very helpful if you have a working knowledge of Microsoft Windows prio r to using 

Huntron Workstation.  

You are allowed to create a backup copy of the software disk. Your purchase 

agreement allows for copies to be made for backup purposes only -  copying for 

distribution or resale is strictly prohibited.   

 

Installation Instructions  

Install the software BEFORE  connecting any hardware. Uninstall any previous versions 

prior to loading the current version.  For more installation details follow the ñGetting 

Startedò sheet included with your Huntron product. 

Uninstall any previous versions of Workstation prior to installing the new version.  

I nsert the Huntron Workstation CDROM . The CDROM should Autorun and beg in the 

installation process. If your PC has Autorun disabled then browse Window and select 

WorkstationSetup.exe. This will begin the installation process. During the install you 

will be asked to install additional software for Access Probers. Select the ap propriate 

response based on your Prober hardware.  

 

Installation of Additional Support Software  

Installation of s oftware  for the support of supported oscilloscopes will be  required for 

th e proper operation and control.  

 

Keysight ( Ag ilent )  DSO1022A  and DSO - X- 2022A  

Insert the Keysight  IO Libraries  Suite CD  or download the software from keysight.com . 

Run the IO Libraries  Suite installer . The install process should begin. Use default 

selections as prompted during the installation process as there are n o speci al 

conditions needed for the oscilloscope  hardware . 

If the Agilent /Keysight  DSO1022 A  is being used copy the ñHuntronE xt ernal3 .dll ò 

file from the path ñC:\ Program F iles \ Huntron Workstation \ E3DSO1022A ò to the path 

ñC:\ Program Files \ Huntron Workstationò. Select ñYesò to overwrite the existing 

ñHuntronE xte rnal3 .dllò file in that path. If the Keysight DS - X- 2022A  is being used 

then use the ñHuntronExternal3.dll ò file from the E3DSOX2022A folder. 
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Hardware Setup  

If a Huntron Access Prober is being used, connect it to p ower.  

Connect the Huntron Access to the PC with the USB Cable.  

Connect the oscilloscope  to Power.  

Connect the oscilloscope  to the PC using the USB cable.  

Using the ñInstallation of Oscilloscope Probe Mounting Kitò instructions, connect the 

oscilloscope  to the Huntron Access by placing the oscilloscope probe into the probe  

adapter mounted to the Z axis  rail  as shown in the image below.  

 

 

A connection from the oscilloscope ground will need to be made to the UUT.  

 

Huntron Workstation Main Interface  

When starting Huntron Workstation for the first time, you will be prompted for an 

activation code. Type in the code exactly as it is presented on the installation CD.  

Use upper case letters and note the differences between the letter ñOò and the number 

zero.  
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The Main Wi ndow for Huntron Workstation 4  features a multi -pane layout. The Panes 

are interactive to a certain degree in that changes in one Pane will affect other Pane s. 

The Panes can be resized, floated independently or ñtabbedò to the sides of the 

window.  The Stat us Bar displays information about items currently selected and status 

information while processes are running.   

The Toolbar  

The Toolbar just under the application menus allows for quick access to several 

program functions. The function of each is broken ou t in the diagram below.  

 

 

 1.  2.  3.  4.  5.  6.  7.   8.   9.  10.   11.  12.  13. 14.  15.  16.  17.  18.  19.  

 

1.  Create New Board database  11.  Scan Component or Net  

2.  Open Board database  12.  Scan Sequence  

3.  Save Asé 13.  Send Prober  head to  Home  position  

4.  Add New (Sequence, Component  or Range)  14.  Connect/Disconnect Prober  

5.  Copy (Sequence, Component, Net  or Range )  15. Connect/Disconnect Tracker  

6.  Paste (Sequence, Component , Net or Range)  16 . Previous Component or Net  

7.  Cut (Sequence, Comp onent , Net or Range)  17 . Next Component or Net   

8.  Delete (Seq ., Comp., Net, Range or Scan)  18.  Previous  Pin 

9.  Build New (Sequence, Component)  19.  Next Pin  

10.  Repeat New  (Sequence, Component)  

Tree Pane  
-  Test and editing  

Signature  Pane  
-  Signature display 
and scanning  

Prober  Pane  
-  Robotic Prober 
control  

Image  Pane  
-  Display of CAD 
layout and PCB 
images  

Status bar  

Tool bars  
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Hardware Setup  

Turn on the Huntron Access and the oscilloscope . Windows will detect New Hardware 

and install the driver needed to communicate with the oscilloscope . 

Agilent /Keysight  Oscilloscope  

Go to the Windows START button, locate and start the Keysight  Connection Expert  

application. Locate the connected oscilloscope by selecting your model in the 

Instruments tab  (see image below). Note the serial number  listed in the Instrument 

properties.  

 

 

 

After verifying that the instrument is properly connected, c lose the  Keysight  

Connection Expert . 

When first starting Huntron Workstation, select Options  from the Tools menu. The 

Options window is used to setup default settings used when working in Huntron 

Workstation.  
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Select the General  tab and set the desire d Unit of Measure (use Microns  for Huntron 

Access  Probers , Mils  for any other Prober).  Also Select Compare Depth of Range . 

 

Select the Hardware  tab and leave the type of Tracker  hardware , the Tracker Port 

and Scanner options at none.  
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If an Access Prober is being used you will  need to select the type of Access Prober, the 

serial port for the Prober and the Frame Grabber type . Select the COM port the Prober  

connection is using by clicking the Find  button  which will search available COM ports 

for the Access USB Prober. Alternatively, go to the Windows Control Panel ,  select 

System  and select Device Manager .  Locate the Ports settings as shown in the image 

below. Use the COM number shown next to ñHS-20USBò.  

 

 

 

Check the Access (2) USB Grey Camera checkbox if you have an Access 2 Prober 

where the camera has a grey colored body rather than black.  

Click the Connect  button  to initiate communication with the selected hardw are.  

 

Select the  tab that is available for your oscilloscope  model  (i.e. DSO1022A ) . For most  

oscilloscopes , set the USB VID PID  (vendor and product IDs), set the Port  for USB , 

Connection to ñNone ò and input the serial number of the oscilloscope  being connected. 

Click the Connect  button  to connect with the oscilloscope . 
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Select the Sequence t ab  and uncheck the Enable Tracker checkbox and check the 

Enable (oscilloscope model)  checkbox.  Check the Enable Access DH  checkbox if 

an Access DH Prober is being used.  

 

 

 

Select the Range tab  and check the box es to enable only Range 1. Set the Range 1 

Tester to your model of oscilloscope  and the Range 1 Delay to 0.  
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Select the oscilloscope  tab  (for your model)  on the Range Tab .  The settings 

available in this tab may vary depending on the oscilloscope  model used.  

You can set the plus and minus T olerance amount, Measurement type, Scale V, 

Nominal measurement value and H Position . Tolerance  is controlled by the 

Comparison setting at the Range level. It can be in mea surement units (i.e. volts , etc.) 

or by percentage. These steps are simply setting defaults for when you add new 

components to the test. You can change the values  in the Tree pane, Ranges tab  at 

any time.  
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Click the Save (Permanent)  button to save this configuration as the startup default.  

 

Using Workstation with a n  Oscilloscope  

An oscilloscope  based test  will typically use  the concept of Test Points (TP). The 

Workstation Software has, for programming purposes, the concept  of compo nents and 

pins. When using an oscilloscope  it is best to think of components as tests and pins as 

Test Points (TP) . 

 

Creating a Oscilloscope  Board Test  

There are a number of steps necessary to creating a n oscilloscope  board test.  

 

Huntron Workstation Test Layout (Tree)

Board (creates an Access .mdb file)

Sequence (test set of Tests) 

Component (Test)  (name, Functional Test)

Pins (TPs) (name; U1.6, TP3, etc.)

Ranges (Measurement settings)

 

 

Example of Board Test Information:  

Board Name: Sample  (creates ñSample .hwdb ò file) 

 Revision: (This field is optional)  

Sequence: Voltage Pk -Pk Measurements   

Component  (Test ) : Test Points  

Pins (TP) : Per TP settings for X, Y, Z locations , etcé 

Ranges: Per TP measurement settings , tolerance, etcé 
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The user has total discretion as to the information input into these fields. There is no 

ñrightò way as to what information is entered as every userôs situation will be different. 

The above example is just one way the information might be entered.  

Entering information into the e ntry windows is very straight forward. The easiest way 

to move from field to field is by pressing the TAB  key. You can also use the mouse to 

click into a particular field so you can enter information.  

 

Test Building Procedures  

-  Determine TP Locations  on the board  and the tests to be performed  

-  Create Test Database in the Tree Pane  

o Add Board, Sequence, and Compo nents  (Test s)   

If an Access Prober is being used:  

-  Perform Camera Offset  

-  Select Alignment points  

-  Teach component pin (TP)  

Using the test:  

-  Scan Sequences and Set Refer ences  

 

Listed above is a general outline on how you would proceed when preparing to test a  

board. As with any type of complex test equipment, practice makes perfect so take the 

time to learn  and practice these procedures.  
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Creating a Board Database  

 

 

To create a new Board, select New  from the File menu or use the New button in the 

toolbar. Inp ut information into the ñAdd New Boardò dialog as needed. The only field 

that is required is board Name  (Example ñSample ò).  Other fields such as Revision, 

System, Unit, Manufacturer and Gold Disk Number can be completed with related 

information  if desired . 

Add ing a  New Sequence  

 

 

To add a new Sequence, select the Sequence  tab in the Tree pane. Select Add New 

Sequence  from the Edit menu or click the Add New button (+)  in the toolbar .  
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Details:  

Sequence Name  Field: Enter Sequence name  

Slot  field: Select the P rober slot that the board will be in when scanning.  

Compare Priority : Selects the signature (or measurement) comparison priority 

between Same  (serial number), All  (serial numbers ; this is the recommended setting ) 

or Min/Max  (Merged min/max signatures)  

The  Delete Scans button will erase all scans for the current Sequence.  

Instructions field : Select the Instructions tab  and e nter any instructions or system 

information that you wish to pass on to future users. Note: the ENTER  key in this field 

will work as a carriage return.  

For oscilloscope tests, select the Testers tab  and check the Enable (model number)  

checkbox. Uncheck Enable Tracker  if it is checked.  

 

Other functions within this window can be read by mousing over the item and viewing 

the Tool Tip or by clicking the HELP  button.  

 

Add ing a  New Component  ( Test )  

 

To add a new Component  (Test ) , select the Component  tab in the Tree pane. Select 

Add New Component  from the Edit menu or click Add New button ( + ) in the toolbar.  
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Details:  

Component Name  field: Enter the component name ( Test  Name ) in this field.  

Package  and Number of Pins  field s:  The Number of Pins should be set to at least the 

number of  TPs in this Test  (component). Select more p ins than the current number of 

TPs allows more TPs to be  added later. For unused pins ( TPs) uncheck the Scan Pin  

check box on the  Pin Tab  after the Component is created . 

Type  field: This information is optional but you can enter the component type in this 

field.  

Pin Spacing : Not used with oscilloscope  tests.  

Connection Type : Set to Prober for Access Prober users  

Open Check Type : Not used by with oscilloscope  tes ts  

Pause checkbox : Sequence tests will pause at this component and display 

instructions  

Test checkbox : Enables or disables testing of the selected comp onent  

Correction Steps : Sets the maximum amount of correction steps used with the 

Huntron Access Prober when moving to the first TP of the Test .  

Instructions  field: Enter any instructions or component information that you wish to 

pass on to future users.  

Other functions within this window can be read about by clicking the HELP  button.  
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Pin Edit  

Settings for individual pins can be modified by open the Pin Edit window. You can open 

the Pin Edit window by selecting t he Pin tab in the Tree pane, right -click the row 

header and select Edit Pin.  

 
 

 

Name : Type directly into the Name field to change the pin name  

Net Name : Type directly into the Name field to change the Net name  

Correction Steps : Modifies the number correction steps used with Access Probers. 

This may need to be modified for very small pitch devices.  

Scan Pin : Enables or disables scanning of the selected pin  

Pause : Prober will pause and display Pin Instructions before scanning  

 

Modifying a  Range  ( Oscilloscope  Measurement  Setup)  

When a new component (Test ) is added to a Sequence default range (s)  are  added to 

each pin (TP). The  defaults are set up in the Tools/Options/Range / (Oscilloscope 

model )  tab. These settings need to be modif ied  based on signal being measured  at 

each TP . The goal is to obtain a good measurement at each TP.  To stop after a failure 

of a particular measure it is best to use multiple Components (Tests) at the same XY 

coordinate each . The test only stops after a component (test) is completed . 
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To edit a Range, select the Range tab in the Tree pane. Select Edit  Range  from the 

Edit  menu or the quick menu shown above. The Edit Range dialog will be displayed.  

The Tester drop menu  shows the instrument used.  

 

 

Select the Tree/Range tab to 

display the ranges for the selected 

component pin. RIGHT click on 

the row header (far left grey area 

of the row) to display a quick 

menu (shown left)  
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Edit  Range Det ails  (settings may be different  based on oscilloscope  model) :  

Note: All of the settings can be modified directly in the Range grid.  

+Tolerance : The amount above the Reference or Nominal Reading which determines 

the High Pass Limit.  This is used during comparison to the value listed in the Nominal 

field.  This amount can be a value or percenta ge depending on the Comparison setting.  

- Tolerance : The amount below the Reference or Nominal Reading which determines 

the Low Pass Limit.  This is used during comparison to the value listed in the Nominal 

field.  This amount can be a value or percentage dep ending on the Comparison setting.  

Measurement : Sets type of oscilloscope  Measurement  

Scale V : Sets the scope Volts/Division  

Scale H : Sets the scope timebase  

Trigger Source : Sets Trigger source i.e. Chan. 1, Chan. 2, External, etc.  

Trigger Coupling : Sets Trigger coupling type i.e. AC, DC, etc.  

Comparison : Sets the comparison mode. Nominal  compares the measurement to 

the entered Nominal value. Reference  compares the measurement to the stored 

reference measurements.  Nominal %  uses the Tolerance setting as a percentage of 

the Nominal value. Reference  %  uses the Tolerance setting as a percentage of the 

Reference value.  

H and V Position : Enter the Vertical Position in divisions | Horizontal Position in 

seconds ; leave blank to defaults  

Trigger : Ente r the Trigger Level in volts | Trigger Holdoff in seconds | Trigger Slope 

(Rise, Fall, Both) ; Example: 1 |0|Rise  

Channel: Enter the channel using channel name | coupling (DC, AC or GND). 

Example: CHAN1|DC  

Nominal : Enter the nominal value for the measurement . This is the value used when 

test Comparison  is set to Nominal .  

BW 25 M : Check for 25MHz bandwidth, uncheck for maximum bandwidth  

Trig Auto : Check to Trigger Auto, uncheck to Trigger Normal  

Invert : Check to Invert the signal, uncheck for normal signal  

Probe 1X : Check fo r 1X Probe, uncheck for 10X Probe  

 



 

©  Huntron, Inc 2016  Rev. B  19  

Mounting a PCB in an Access Prober  

Before software functions relating to an Access Prober can be performed, the PCB 

under test must be mounted into the Prober test area. Use the mounting accessories 

supplied with the Prober to securely mount your PCB by its edges.  

 

 

 

Refer to the Access Prober Users manual for more information on mounting a PCB. In 

some cases, a PCB holder is the best solution especially when the PCB cannot be easily 

mounted using the standard accessories. PCB holders are typically simple to construct 

and the only prerequisites are that the holder fit into the Prober and that it holds the 

PCB precisely at one of the designated Prober ñSlotsò. The Slots are referred to by the 

position in the Prob er as TOP, MIDDLE, BOTTOM and BASE (Access 2 and Access DH 

only) and are set in the Sequence Edit window (see section ñAdding a New 

Sequence ò). 
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Prober Setup ï Camera Offset part 1   

 

 

Performing the Camera Offset procedure is essential for the Prober t o access test 

points accurately.   

Select the Offset  tab in the Prober pane . 

Navigate the Camera to a target on the PCB.  A very small target that is still visible by 

eye works best.  Use the arrow buttons to move the camera the distance set in the 

travel dis tance field (directly below the arrow buttons). You can also click directly in 

the camera image to move the camera crosshairs to the clicked location.  

When the target is selected, press Set .  

Select Prober  in the Mode drop menu to move to the next step . 

 

Prober Setup ï Camera Offset part 2  

 


